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Instructions

Gateway Network 
Communication 
Assembly
Used to control, monitor, and download production data from various Graco System 
Controllers to a PLC or PC for automation or production information reporting. For 
professional use only.

Not approved for use in explosive atmospheres or hazardous (classified) locations. 

See pages 3 and 4 for information and model numbers 
for each Gateway Assembly.

Important Safety Instructions
Read all warnings and instructions in this 
manual and in your proportioning system 
manual before using the equipment. 
Save all instructions. 
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Gateway Assembly Overview
The Gateway Network Communication Assembly 
(referred to as Gateway Assembly throughout this man-
ual) enables various Graco systems to communicate 
with PLCs (programmable logic controllers) and network 
communication systems. Communication assemblies 
are available for many different communication proto-
cols, including Modbus TCP, Ethernet IP, DeviceNet, 
and Profibus. The Gateway Assembly supports many 
other protocols; contact Graco Technical Assistance for 
information to support your desired protocol.

NOTE: Only persons very familiar with their PLC and 
Network communication architecture should use this 
hardware and software. This manual assumes that the 
person using the Gateway Assembly has full under-
standing of the PLC equipment and related software.

NOTE: Network communications essentially operate 
with the same rules as Discrete I/O. However, network 
communications require placing correct values or 
adjusting appropriate bits within various registers 
depending on the protocol. Network communications 
should only be installed by qualified persons familiar 
with this type of communication.

The Red Lion Gateway Module allows for most PLCs to 
communicate with the various Graco systems via the 
protocol selected by mapping registers from the Graco 
system to the PLC or communications hardware of 
choice. Software is available to do this, as well as pre-
configured database mappings from Graco for various 
Graco systems. As a result, the PLC has full access to 
all the registers for monitoring and controlling the Graco 
system. It is the responsibility of the integrator or user to 
ensure proper configuration of the communication hard-
ware on the PLC side. 

NOTE: The Red Lion Gateway Module (Graco part no. 
18C235) used in each Gateway Assembly is the core 
communication component of all five Gateway 
Assembly models covered in this manual. The Red Lion 
Gateway Module includes Modbus TCP, Modbus RTU 
Serial, and many other protocols. 

Gateway Terminology
The following terminology is used throughout this 
manual when referring to Gateway Assemblies and 
components:

Gateway Assemblies

Model 25B471 Gateway Ethernet Assembly
Allows communication between various Graco systems 
with a PLC and other communications hardware over an 
ethernet. Enables process equipment to read and write 
communication network variables from various Graco 
systems.

Model 25B472 Gateway DeviceNet 
Assembly
Allows communication between various Graco systems 
with a PLC and other communications hardware using 
DeviceNet process control. Enables process equipment 
to read and write variables from various Graco systems. 
See Appendix A: DeviceNet® Secondary 
Communication on page 32 for DeviceNet details.

Model 25B473 Gateway Profibus Assembly
Allows communication between various Graco systems 
with a PLC and other communications hardware using 
Profibus process control. Enables process equipment to 
read and write variables from various Graco systems. 
See Appendix B: Profibus® DP Secondary 
Communication on page 35 for DeviceNet details.

Term Definition
Gateway 
Module

Red Lion Gateway and protocol 
converters.

Gateway 
Assembly

A Red Lion Gateway Module with an 
enclosure and power supply.

Graco System 
Controller

Any Graco System Controller like, but 
not limited to, EasyKey, ProDispense, 
ProControl 1KE Plus, Graco 
DCM/ADCM, ACS, etc.
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Model 25B486 Gateway Ethernet Assembly 
with 16K465 Fiber Conversion Module
Allows communication with a Graco ADCM and DCM 
control module through a fiber cable in hazardous and 
non-hazardous locations.

NOTE: This communication method is used for the 
ADCM and DCM modules, regardless of where they are 
placed.

Model 25B489 Gateway Ethernet Assembly 
with Ethernet Switch
Gateway Ethernet Assembly with an 8-port Ethernet 
switch that allows communication with up to seven 
Graco ACS modules via an Ethernet network.
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Warnings
The following warnings are for the setup, use, grounding, maintenance, and repair of this equipment. The 
exclamation point symbol alerts you to a general warning and the hazard symbols refer to procedure-specific risks. 
When these symbols appear in the body of this manual or on warning labels, refer back to these Warnings. 
Product-specific hazard symbols and warnings not covered in this section may appear throughout the body of this 
manual where applicable.

WARNING
FIRE AND EXPLOSION HAZARD
Flammable fumes, such as solvent and paint fumes, in work area can ignite or explode. Paint or 
solvent flowing through the equipment can cause static sparking. To help prevent fire and explosion: 

• Use equipment only in well-ventilated area.
• Eliminate all ignition sources; such as pilot lights, cigarettes, portable electric lamps, and plastic drop 

cloths (potential static sparking).
• Ground all equipment in the work area. See Grounding instructions.
• Never spray or flush solvent at high pressure.
• Keep work area free of debris, including solvent, rags, and gasoline.
• Do not plug or unplug power cords, or turn power or light switches on or off when flammable fumes 

are present.
• Use only grounded hoses.
• Hold gun firmly to side of grounded pail when triggering into pail. Do not use pail liners unless they 

are anti-static or conductive.
• Stop operation immediately if static sparking occurs or you feel a shock. Do not use equipment until 

you identify and correct the problem.
• Keep a working fire extinguisher in the work area.

ELECTRIC SHOCK HAZARD
This equipment must be grounded. Improper grounding, setup, or usage of the system can cause 
electric shock.

• Turn off and disconnect power at the main switch before disconnecting any cables and before 
servicing or installing equipment. 

• Connect only to grounded power source.
• All electrical wiring must be done by a qualified electrician and comply with all local codes and 

regulations.
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EQUIPMENT MISUSE HAZARD
Misuse can cause death or serious injury.

• Do not operate the unit when fatigued or under the influence of drugs or alcohol.
• Do not exceed the maximum working pressure or temperature rating of the lowest rated system 

component. See Technical Specifications in all equipment manuals.
• Use fluids and solvents that are compatible with equipment wetted parts. See Technical 

Specifications in all equipment manuals. Read fluid and solvent manufacturer’s warnings. For 
complete information about your material, request Safety Data Sheets (SDSs) from distributor or 
retailer.

• Do not leave the work area while equipment is energized or under pressure.
• Turn off all equipment and follow the Pressure Relief Procedure when equipment is not in use.
• Check equipment daily. Repair or replace worn or damaged parts immediately with genuine 

manufacturer’s replacement parts only.
• Do not alter or modify equipment. Alterations or modifications may void agency approvals and create 

safety hazards.
• Make sure all equipment is rated and approved for the environment in which you are using it.
• Use equipment only for its intended purpose. Call your distributor for information.
• Route hoses and cables away from traffic areas, sharp edges, moving parts, and hot surfaces.
• Do not kink or over bend hoses or use hoses to pull equipment.
• Keep children and animals away from work area.
• Comply with all applicable safety regulations.

PERSONAL PROTECTIVE EQUIPMENT
Wear appropriate protective equipment when in the work area to help prevent serious injury, including 
eye injury, hearing loss, inhalation of toxic fumes, and burns. Protective equipment includes but is not 
limited to:

• Protective eyewear, and hearing protection. 
• Respirators, protective clothing, and gloves as recommended by the fluid and solvent manufacturer.

WARNING
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Install the Gateway Assembly Hardware

Location

Install the Gateway Assembly near the Graco System 
Controller in a non-hazardous location.

Mounting
1. See Dimensions, page 38.

2. Ensure the wall or mounting structure is sturdy 
enough to support the assembly and connection 
cabling, and without excessive vibrations that could 
cause reduced component performance or failure.

3. Using the equipment as a template, mark the 
mounting holes on the wall at a convenient height 
for the operator and so equipment is easily accessi-
ble for maintenance. 

4. Drill mounting holes in the wall. Install anchors as 
needed.

5. Bolt equipment securely.

This equipment is not for use in explosive 
atmospheres or hazardous locations. To reduce the 
risk of fire or explosion, do not install equipment 
approved only for non-hazardous location in a 
hazardous location.

FIG. 1: Gateway Assembly Typical Installation 

TI13939b

Computer (PC)

Programmable Logic Controller (PLC)

Gateway Assembly

Graco System Controller

USB Cable 
(included with all 

models); for initial 
setup only

2-wire twisted 
pair cable, with 
shield wire, 
CATV cable or 
fiber optic cable

PLC Communication 
Wire/Cable 

(protocol dependent)

NON-HAZARDOUS LOCATION
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Connect Gateway Assembly 
Communication to the Graco 
System Controller

FIG. 2: Power Off

FIG. 1 is only a guide showing installation of the Gate-
way Assembly in a ProMix 2KS System; it is not a com-
plete system design. Contact your Graco distributor for 
assistance in designing a system to suit your particular 
needs. This procedure is an example of how to connect 
the Gateway Assembly to a Graco EasyKey, though it 
may also apply to other Graco System Controllers.

1. Shut off power at the main circuit breaker

2. Shut off ProMix 2KS power (0 position). See FIG. 2. 

3. Turn off power to the Graco EasyKey and the 
Gateway Assembly before connecting or 
disconnecting communication cables.

NOTE: For specific system communication circuit 
connections and register mapping details, refer to the 
following product family manuals: ProMix 2KS (312779), 
ProControl 1KE (3A6948 and 332013), Graco ACS 
Module (3A0006), and Graco ProDispense (3A3469).

4. Connect a 2-wire twisted pair cable (provided with 
assemblies 25B471-25B473), see FIG. 5, with shield 
wire from the EasyKey connector to the connector 
on the Gateway Module. 

5. Connect a communications wire/cable (protocol 
dependent) from the Gateway Module to the PLC. 
(See Communication Connections, page 11.)

NOTE: Graco provides expansion cards for DeviceNet 
and Profibus protocols. DeviceNet setup procedures are 
on page 32. Profibus setup procedures are on page 35. 
See Parts, page 26, for part numbers.

NOTE: When using the Gateway Assembly in your sys-
tem, disconnect both communication cables (one to the 
Graco System Controller and the other to the PC or 
PLC) before updating the system software.

Grounding

Gateway Assembly
Grounding is provided by both a proper power connec-
tion and a grounding screw on the enclosure. 

• For a proper power connection, see Power 
Connections, page 9, and Electrical Schematics, 
page 16, for details and grounding locations.

• For the enclosure grounding screw (4), use a 
ground wire (35) and clamp (supplied). Remove the 
grounding screw (4). Attach the ground wire (35) 
end, as shown, and tighten the ground screw (4) 
securely. Connect the ground clamp to a true earth 
ground.

: 

0 = OFF

TI12657a

The equipment must be grounded to reduce the risk 
of static sparking and electric shock. Electric or static 
sparking can cause fumes to ignite or explode. 
Improper grounding can cause electric shock. 
Grounding provides an escape wire for the electric 
current. 

FIG. 3: Enclosure Grounding

4

35
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Power Connections

The Gateway Assembly is rated for 100-240 VAC, 50-60 
Hz, with a maximum of 1 amp current draw. Power 
connections are common to all Graco Assembly models. 
See FIG. 4. For specific wiring details, see Electrical 
Schematics on page 16.

NOTE: A means of disconnect must be provided during 
installation. Branch circuit protection of 15 amp 
maximum must be provided during installation. Power 
wires must be made of copper and have a minimum 
temperature rating of 140°F (60°C). The wire gauge size 
must be 12-14 AWG.

1. Disconnect power to the Graco System Controller. 

2. Disconnect power to the Gateway Assembly.

3. Loosen the screws (3) and remove the enclosure 
cover (2). See Parts, starting on page 24.

4. Route the power cable from a 100-240V, 50/60 Hz, 
AC power source through the hole provided in the 
bottom of the enclosure (1).

NOTE: The strain relief fitting or connector must be 
provided in the field according to local electrical codes.

5. Connect the supply ground wire to the ground 
terminal block (9) in the enclosure (1).

6. Connect the incoming power wires (L and N) to the 
labeled L and N terminals on the 24 V power supply 
(10). Gently pull on all connections to verify they are 
properly secured.

7. Torque the power input terminal screws to 0.56 N•m 
(5 in-lb).

8. Connect the communication cables (see Communi-
cation Connections, pages 11-13, and Electrical 
Schematics, pages 16-18). 

9. Verify that all items are connected properly, then 
replace the enclosure cover (2) and tighten the 
screws (3).

Improper wiring may cause electric shock or other 
serious injury if work is not performed properly.

• This equipment must be grounded. Connect only 
to a grounded power source.

• All electrical wiring must be done by a qualified 
electrician and comply with all local codes and 
regulations.

NOTICE
If power and grounding connections are not done 
properly, the equipment will be damaged and the 
warranty voided.
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FIG. 4. Power Connections

14
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Model 25B471 Models 25B472 and 25B473

Model 25B486 Model 25B489
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Communication Connections

See FIG. 9 and FIG. 10 for typical cable connections in a 
ProMix 2KS system. 

FIG. 11 and FIG. 12 show other possible cable connec-
tions.

Refer to your Graco system manual for communication 
protocol and connection requirements to complete your 
specific Gateway Assembly installation. System manu-
als have details for protocol and connections.

For example, 

2-wire twisted pair 
cable, with shield wire. 
See Electrical Sche-
matics on page 16 for 
pin connections.

Communication Wire/Cable (to PLC). 
This connection is protocol dependent. 

USB Port

Models 25B471/2/3 
come with 50 ft. of the 
twisted pair cable for 
an RS485 connection.

FIG. 5: Gateway Ethernet Assembly Cable Connection Points - Model 25B471

• A Graco EasyKey (ProMix 2KS) requires an RS485 
connection. See FIG. 6.

• An DCM/ADCM (ProControl 1KE Plus and 
Intelligent Paint Kitchen) requires a fiber optic 
converter and connection. See FIG. 7.

• An ACS controller can use an RS485 or EtherNet 
switch; determine the protocol to be used and make 
the appropriate connection. See FIG. 8.



2-wire twisted pair 
cable, with shield wire 
(to EasyKey). See 
Electrical Schematics 
on page 17 for pin con-
nections.

Gateway Assembly

USB Port Models 25B471/2/3 
come with 50 ft. of the 
twisted pair cable for 
an RS45 connection.

External control 
network cable

FIG. 6: Gateway DeviceNet and Profibus Assembly Cable Connection Points - Models 25B472 and 25B473

Optional fiber optic cable 
for connection to an 
ADCM or DCM module. 
Cable options are, 

• 17T898 (3 m)
• 16M172 (15 m)
• 16M163 (30 m)
• 17B160 (100 m)

Gateway Assembly
with Fiber Optic communication conversion to the PC/PLC

USB Port

FIG. 7: Gateway Ethernet Assembly w/Fiber Optic Conversion Cable Connection Points - Model 25B486
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Gateway Assembly
with EtherNet Switch for EtherNet conversion to the PC/PLC

USB Port

Ethernet network cable

FIG. 8: Gateway Ethernet Assembly w/Ethernet Switch Cable Connection Points - Model 25B489
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FIG. 11: Programming Port Options

FIG. 12: Ethernet Connection

GREEN/AMBER
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ETHERNET

USB/PG

A USB/PG port cable 
is provided with all 
models for configura-
tion and setup.

GREEN/AMBER
LED
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LED

ETHERNET
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Electrical Schematics

FIG. 13: Electrical Schematic - Model 25B471
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FIG. 14: Electrical Schematic - Model 25B472 and 25B473

FIG. 15: Electrical Schematic - Model 25B486
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Install SD Card (17R419)
NOTE: One SD card is provided with each Gateway 
Assembly.

The SD socket accepts either Type I or Type II cards. 
These cards are available at most computer and office 
supply retailers. Use cards with a minimum of 4 Mbytes 
and a maximum of 2 Gbytes. Use the SD card for 
optional database storage only. See FIG. 17.

1. Disconnect power to the Gateway Assembly and 
remove the cover.

2. Install the SD card in the orientation shown in FIG. 
17.

3. Install the Gateway Assembly cover and connect 
power.

 

FIG. 16: Electrical Schematic - Model 25B489
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Install the Red Lion™ Crimson® 3.0/3.1 Software
NOTE: Use of the term “target device” in this section is 
consistent with documentation provided by Red Lion 
and refers the Red Lion Gateway Module referenced 
earlier in this manual.

Red Lion Crimson 3.0/3.1 software provides access to 
the Gateway Assembly hardware. The CD provided 
includes a preconfigured database which is essentially a 
setup file for the Gateway Assembly for various Graco 
System Controllers. Refer to your appropriate Graco 
system manual for which of the databases to be used, 
or contact Graco for optional preconfigured mapping 
databases. The database file has a .cd31 extension.

The Gateway Assembly provides conversions for many 
protocols, including the following:

• All Allen-Bradley protocols
• DeviceNet
• Ethernet TCP/IP
• Ethernet IP
• Mitsubishi
• Modbus (ASCII, RTU)
• Profibus
• Siemens

NOTE: Graco provides expansion cards for DeviceNet 
and Profibus protocols. DeviceNet setup procedures are 
on page 32. Profibus setup procedures are on page 35. 
See page 24 for Parts. 

NOTE: Contact your Graco distributor or Graco Techni-
cal Assistance for information regarding additional sup-
ported protocols.

System Requirements
Crimson 3.1 is designed to run on any version of Micro-
soft Windows from Windows Vista onward. Memory 
requirements are modes and any system that meets the 
minimum system requirements for its operating system 
will be able to run Crimson 3.1. About 600MB of free 
disk space will be needed for installation, and you 
should ideally have a display with sufficient resolution to 

allow the editing of display pages without having to 
scroll.

Installing the Software
Crimson 3.1 is supplied as an executable or .exe file. 
You will typically have downloaded this file from Red 
Lion’s website, but if you have downloaded it from 
another source, please check that Windows is satisfied 
with the package’s digital signature so that you are 
assured of receiving genuine Red Lion software.

1. Disconnect power to the Gateway Assembly and 
remove the cover.

2. Connect the USB cable (23, supplied) between the 
USB port on the Gateway Module and a USB port 
on your PC. See FIG. 18.

3. Connect power to the Gateway Assembly and refer 
to the Red Lion Crimson website 
(https://redlion.net/red-lion-software/crimson/crimson-31) 
for download and usage instructions for the Crimson 
Software.

NOTE: The supplied Crimson 3.1 User Manual is 
available for download at the Crimson Software web 
page at the link in step 3.

FIG. 18: Gateway Module USB Port

USB Port

USB Cable Strain Relief
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4. Follow the PC software installation instructions.

NOTES: 

• Connecting the USB cable (23) to the Gateway 
Assembly and your PC should automatically load 
the proper drivers. Contact Graco Technical 
Assistance to ensure the proper drivers are installed 
for your PC if there are software installation 
difficulties.

• Graco provides preconfigured files of the data 
variable mappings for the specific Graco system 
connected to your Gateway Assembly. This 
configuration may be sent by email or by purchasing 
a preconfigured file on an SD Card. Follow the 
communications manual for the specific Graco 
system used.

• If you’ve followed the instructions that came with 
your target hardware, you will not yet have 
connected the hardware to your PC. Now that you 
have completed the Crimson 3.1 installation, you 
may safely connect the device using a standard 
USB cable. After some churning, Windows should 
indicate that it has found the drivers for the new 
hardware and that it is ready for operation. No 
further user intervention should be required.

Registration
When you first run Crimson 3.1, you will be offered a 
chance to register your software. While registration is 
optional, we strongly recommend that you take the 
opportunity to provide us with your contact details so 
that we can keep you informed about updates to 
Crimson 3.1 and the associated products. Since 
registration requires an Internet connection, you may 
skip the process if you do not have such a connection 
available. Crimson 3.1 will periodically remind you if you 
are running an unregistered copy of the software. 

Checking for Updates
If you have an Internet connection, you can use the 
Check for Update command in the Help menu to scan 
Red Lion’s website for a new version of Crimson 3.1. If a 
later version than the one you are using is found, 
Crimson will ask if it should download the upgrade and 
update your software automatically. You may also 

manually download the upgrade from Red Lion’s 
website by visiting the Downloads page within the 
Support section.

Troubleshooting
If you connected the target Red Lion Gateway to your 
PC before installing Crimson, it is possible that an 
aborted installation has made it impossible for you to 
install the drivers correctly. To check for this, open the 
Windows Device Manager by finding the My Computer 
icon, right-clicking and selecting the Manage command. 

The exact process for getting to this point will vary from 
one operating system to another, but the basic idea is 
the same: Find the My Computer icon, either on the 
desktop or on your start menu, right-click it and select 
Manage. If that doesn’t work, select the System option 
from the Control Panel, and activate the Device 
Manager from the Hardware tab. 

If you have a problem with your USB drivers, you will 
see a yellow icon carrying an exclamation point under 
the Universal Serial Bus controllers category. The name 
of the icon may be HMI or Loader or something similar. 

To fix the problem, right-click on the broken device and 
select Uninstall from the menu.

After asking for confirmation, Windows will remove the 
device from your system. You can now power the 
Crimson 3.1 target device off. After a couple of seconds, 
reapply power and Windows will start the driver 
installation process once again. 

As mentioned above, Crimson 3.1 actually uses distinct 
device drivers for the boot loader and for the Crimson 
runtime. You may have to repeat this repair process for 
each driver, although it is unlikely that things got beyond 
the boot loader if that install failed.

LEDs

LEDs Description

STS Status LED indicates condition of the 
Gateway Assembly.

TX/RX Transmit/Receive LEDs show serial activity.

Ethernet Link and activity LEDs.

CF CompactFlash LED indicates card status 
and read/write activity
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Getting Assistance
If you hit a problem or need assistance, several 
resources are available. 

Balloon Help
Crimson 3.1 contains a very useful feature called 
Balloon Help. This feature allows you to see help 
information for each item within Crimson 3.1. It is 
controlled via the icon at the right-hand edge of the 
toolbar or via options on the Help menu. The default 
mode allows the help text to be displayed by pressing 
the F1 key, providing a quick way of getting information if 
you are unsure of the settings for a given field. Keep this 
in mind, and your life will be a lot easier! 

Technical Support
Technical assistance is available on the web at:

www.redlion.net/support.html 

Or, Red Lion can be contacted via email at:

support@redlion.net 

You may also call +1 (717) 767-6511 and ask for the 
HMI Support Team. 

Downloading to a Device
Crimson 3.1 database files are downloaded to the target 
device by means of the Link menu. The download 
process typically takes only a few seconds, but can take 
somewhat longer on the first download if Crimson has to 
update the firmware in the device, or if the device does 
not contain an older version of the current database. 
After this first download, Crimson uses a process known 
as incremental download to ensure that only changes to 
the database are transferred. This means that updates 
can be made in seconds, thereby reducing your 
development cycle time and simplifying the debugging 
process. 

Configuring the Link
The programming link between the PC and the target 
device can be made using a USB port or a TCP/IP 
connection. First time updates of databases use the 
USB port. Further updates may be made by the TCP 
port if configured properly within the updated database 
and the IP address is known. Before downloading, use 
the Link-Options command to ensure that you have the 
correct method selected.

Note that this dialog does not provide any method to 
select the target IP address when using TCP/IP for 
download. This information is stored in the database file 
and is configured via the Download tab of the Network 
configuration item. This method makes it easier to 
switch between multiple databases without having to 
re-configure the target IP every time. Note also that 
Crimson 3.1 maintains distinct download settings when 
working with multiple product families. This makes it 
easier to use USB for downloading to those products 
that support it, while falling back to serial download for 
less capable devices. 
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Sending the Database
Once the link is configured, the database can be 
downloaded using either the Link-Send or Link-Update 
commands. The Link-Send command will send the 
entire database, whether or not individual objects within 
the file have changed. The Link-Update command will 
only send changes, and will typically take a much 
shorter period of time to complete. The Link-Update 
command is typically the only one that you will need, as 
Crimson 3.1 will automatically fall back to a complete 
send if the incremental download fails for any reason. 
As a shortcut, you can access Link-Update via the 
lightning bolt symbol on the toolbar, or via the F9 key on 
the keyboard. 

NOTE: Downloading via TCP/IP to some models relies 
on a memory card being installed if the device’s 
firmware is to be upgraded. Since you may want to 
perform such upgrades at some point in time, it is highly 
recommended that you install a memory card in any 
device to which TCP/IP downloads are likely to be 
performed. Note also that the TCP/IP download option 
must be enabled via the Network settings in the 
Communications category.

Extracting Databases
The Link-Support Upload command can be used to 
include the information necessary to support database 
upload when sending a database to a target device. 
This setting is stored in the database and can be 
configured on a perfile basis. Enabling database upload 
will slow the download process somewhat and may fail 
with extremely large databases containing many 
embedded images, but it will ensure that, should you 
lose your database file, you will be able to extract an 
editable image from the device. 

NOTE: If you lose your database file and you do not 
have upload support enabled, you will not be able to 
reconstruct your file without starting from scratch. To 
extract a database from a panel, use the Link-Extract 
command. This command will upload the database, and 
prompt you for a name under which to save the file. The 
file will then be opened for editing. If the database was 
password-protected, you may be required to enter the 
password before it can be opened. In other words, 
enabling upload will not circumvent password 
protection. 

Sending the Time and Date
The Link-Send Time command can be used to set the 
target device’s clock to match that of the computer on 
which Crimson 3.1 is executing. This command also 
sends the current time zone and Daylight Savings Time 
settings to the target device, allowing the advanced 
features of the Time Manager to be used. Note that an 
accurate clock setting is required for certain features to 
work reliably, most notable those associated with 
SSL-TLS security.

Software Updates
Contact your distributor or Graco Technical Assistance 
for software updates. Refer to Installing the Software, 
page 19, for installing software updates.
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Download the Preconfigured Database to the Gateway Module
Graco can supply a preconfigured database as a setup 
file for the Gateway, containing parameters which com-
municate between the Gateway and various Graco con-
trol platforms. The file name has a .cd31 extension.

Red Lion Crimson 3.0/3.1 files are downloaded to the 
Gateway module using the Link menu. The program-
ming link between the PC and the Gateway module 
uses the USB cable. Before downloading, check that the 
Communications Port is set to USB, as follows.

NOTE: During programming the Gateway module may 
ask for an updated driver. Follow the instructions on the 
screen to automatically find and select the drivers.

1. Go to Start>Programs>Graco>Red Lion Crimson 
3.0/3.1 and run the program. The Red Lion Crimson 
3.0/3.1 main page will appear.

2. Using the Link pulldown menu, select Options to 
open the Link Options window. Check that the Com-
munications Port is set to USB, and click OK.

3. Go to File>Open and select the file with the xx.cd31 
extension. The file name should appear at the top of 
the window once loaded.

4. Download the database using the Link>Update 
command. As a shortcut, use the Update symbol on 
the toolbar. See FIG. 19.

NOTE: Downloading typically takes only a few sec-
onds but may take longer if the software has to 
update firmware on the Gateway module.

FIG. 19 Red Lion Crimson 3.0/3.1 Main Page

FIG. 20: Set Communications Port to USB



Parts 

24 3A7639A
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25B471 Gateway Ethernet Assembly
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25B471 Gateway Ethernet Assembly Parts List

 Replacement safety labels, tags, and cards are avail-
able at no cost. 

Parts labeled n/a are not available separately.

NOTE: All brand names or marks are used for identifica-
tion purposes and are trademarks of their respective 
owners.

Ref. Part No. Description Qty
1 15V339 Enclosure 1
2 15T752 Cover 1
3 n/a Screw, machine, serrated 

hex-head
4

4 116343 Screw, ground 1
5 186620 Label, ground 2
6 n/a Din rail 1
7 103833 Screw, machine, CRBH 4
8 120838 End block, din rail 2
9 112443 Terminal block, ground 1
10 19Y920 Power supply 1
13 15V344 Connection converter, terminal 

block to RJ45
1

14 18C235 Gateway Assembly 1
16 15V345 Grommet, cable entry 2
18 n/a Wireway 1
19 n/a Cover, wireway 1
20 15U918 Label, product 1
23 15W776 Label, warning, electrical 1

24 121994 Cable, CATV 1
25 121700 Cable, 2 conductor, RS485, 50 

ft.
1

26 065145 Wire, electrical, copper 1
27 112515 Ferrule, wire, red; not shown 4
28 547005 Wire, power, 24 VDC +, blue 1
30 555770 Wire, ground, green 1
31 112514 Ferrule, wire, AWG-18; not 

shown
2

33 17R419 Card, SD; not shown 1
34 15T999 Cable, USB, 5 meters; not 

shown
1

35 223547 Cable, ground, 25 ft. 1

Ref. Part No. Description Qty
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25B472 Gateway DeviceNet Assembly
25B473 Gateway Profibus Assembly
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25B472 Gateway DeviceNet Assembly Parts List

25B473 Gateway Profibus Assembly Parts List

 Replacement safety labels, tags, and cards are avail-
able at no cost. 

Parts labeled n/a are not available separately.

NOTE: All brand names or marks are used for identifica-
tion purposes and are trademarks of their respective 
owners.

Ref. Part No. Description Qty
1 15V339 Enclosure 1
2 15T752 Cover 1
3 n/a Screw, machine, serrated 

hex-head
4

4 116343 Screw, ground 1
5 186620 Label, ground 3
6 n/a Din rail 1
7 103833 Screw, machine, CRBH 4
8 120838 End block, din rail 2
9 112443 Terminal block, ground 1
10 19Y920 Power supply 1
13 15V344 Connection converter, terminal 

block to RJ45
1

14 18C235 Gateway Assembly 1
15 Card, expansion

18C236 DeviceNet (25B472 only) 1
18C237 ProfiBus (25B473 only) 1

16 15V345 Grommet, cable entry 2
18 n/a Wireway 1
19 n/a Cover, wireway 1

20 15U918 Label, product 1
23 15W776 Label, warning, electrical 1
24 121994 Cable, CATV 1
25 121700 Cable, 2 conductor, RS485, 50 ft. 1
26 065145 Wire, electrical, copper 1
27 112515 Ferrule, wire, red; not shown 4
28 547005 Wire, power, 24 VDC +, blue 1
29 114090 Terminal 1
30 555770 Wire, ground, green 2
31 112514 Ferrule, wire, AWG-18; not shown 3
33 17R419 Card, SD; not shown 1
34 15T999 Cable, USB, 5 meters; not shown 1
35 223547 Cable, ground, 25 ft. 1

Ref. Part No. Description Qty
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25B486 Gateway Ethernet Assembly with Fiber Conversion Module 
16K465
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25B486 Gateway Ethernet Assembly with Fiber Conversion Module 16K465 Parts List

 Replacement safety labels, tags, and cards are avail-
able at no cost. 

Parts labeled n/a are not available separately.

NOTE: All brand names or marks are used for identifica-
tion purposes and are trademarks of their respective 
owners.

Ref. Part No. Description Qty
1 15V339 Enclosure 1
2 15T752 Cover 1
3 n/a Screw, machine, serrated 

hex-head
4

4 116343 Screw, ground 1
5 186620 Label, ground 2
6 n/a Din rail 1
7 103833 Screw, machine, CRBH 4
8 120838 End block, din rail 2
9 112443 Terminal block, ground 1
10 19Y920 Power supply 1
11 16K465 Converter, serial to fiber optic 1
14 18C235 Gateway Assembly 1
16 15V345 Grommet, cable entry 2
18 n/a Wireway 1
19 n/a Cover, wireway 1
20 15U918 Label, product 1
23 15W776 Label, warning, electrical 1

26 065145 Wire, electrical, copper 2
27 112515 Ferrule, wire, red; not shown 8
28 547005 Wire, power, 24 VDC +, blue 2
30 555770 Wire, ground, green 1
31 112514 Ferrule, wire, AWG-18; not 

shown
2

32 19Y992 Cable, Gateway to fiber conver-
sion module

1

33 17R419 Card, SD 1
34 15T999 Cable, USB, 5 meters; not shown 1
35 223547 Cable, ground, 25 ft. 1

Ref. Part No. Description Qty



Parts 

30 3A7639A

25B489 Gateway Ethernet Assembly with Ethernet Switch 15V342
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25B489 Gateway Ethernet Assembly with Ethernet Switch 15V342 Parts List

 Replacement safety labels, tags, and cards are avail-
able at no cost. 

Parts labeled n/a are not available separately.

NOTE: All brand names or marks are used for identifica-
tion purposes and are trademarks of their respective 
owners.

Ref. Part No. Description Qty
1 15V339 Enclosure 1
2 15T752 Cover 1
3 n/a Screw, machine, serrated 

hex-head
4

4 116343 Screw, ground 1
5 186620 Label, ground 3
6 n/a Din rail 1
7 103833 Screw, machine, CRBH 4
8 120838 End block, din rail 2
9 112443 Terminal block, ground 2
10 19Y920 Power supply 1
12 15V342 Switch, ethernet 1
14 18C235 Gateway Assembly 1
16 15V345 Grommet, cable entry 2
18 n/a Wireway 1
19 n/a Cover, wireway 1
20 15U918 Label, product 1

23 15W776 Label, warning, electrical 1
24 121994 Cable, CATV 1
26 065145 Wire, electrical, copper 1
27 112515 Ferrule, wire, red; not shown 8
28 547005 Wire, power, 24 VDC +, blue 2
29 114090 Terminal 1
30 555770 Wire, ground, green 1
31 112514 Ferrule, wire, AWG-18; not shown 3
33 17R419 Card, SD; not shown 1
34 15T999 Cable, USB, 5 meters; not shown 1
35 223547 Cable, ground, 25 ft. 1

Ref. Part No. Description Qty
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Appendix A: DeviceNet® Secondary Communication

Overview
This appendix describes the Gateway’s support for 
DeviceNet and details the configuration steps necessary 
to use this feature. It does not provide a detailed 
description of DeviceNet, but only a brief introduction, 
necessary to define the terms that are used throughout 
the remainder of this document.

Introduction
DeviceNet is a low-level network using the Controller 
Area Network (CAN) technology, to provide communica-
tion between a range of industrial devices, from simple 
devices such as sensors and actuators, to high-level 
devices such as controllers and HMIs.

DeviceNet Port Protocols
The DeviceNet option card has one DeviceNet port. See 
FIG. 21. The port may be configured for various Devi-
ceNet protocols. Contact Graco Technical Assistance 
for currently supported protocols.

DeviceNet Option Card Pin Outs
• V-

Position 1 of the pluggable connector provides a 
CAN ground connection. This terminal is isolated 
from the Gateway Assembly.

• CAN_L
Position 2 of the pluggable connector provides the 
CAN_L bus line (active low). This terminal is iso-
lated from the Gateway Assembly.

• DRAIN (optional)
Position 3 of the pluggable connector is provided for 
optional drain connections. This position is available 
only to tie drain wires together or to earth ground. 
There is no internal connection to earth ground. The 
DRAIN position is not connected to any circuitry 
internal to the DeviceNet option card.

• CAN_H
Position 4 of the pluggable connector provides the 
CAN_H bus line (active high). This terminal is iso-
lated from the Gateway Assembly.

• V+ (optional 24 Vdc)
Position 5 of the pluggable connector is provided for 
optional 24 Vdc connections. This position is avail-
able only to tie 24 Vdc wires together. The Devi-
ceNet option card neither provides or uses 24 Vdc 
power through this connection. The V+ position is 
not connected to any circuitry internal to the Devi-
ceNet option card or Gateway Assembly.
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FIG. 21: DeviceNet Port Pin Outs and PLC Connection
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About DeviceNet
DeviceNet is a connection-based network. In this con-
text the term connection refers to a communication path 
between two or more devices, and not the physical 
(cable) connection to the DeviceNet network. A connec-
tion must be established between two devices in order 
to transfer data.

There are two types of connection defined by the Devi-
ceNet specification. Each has different characteristics 
and is suited to a specific type of communication.

• I/O Connection – Dedicated data transfer between 
a producer and one or more consumers. The format 
of the data is known or implied by the connection.

• Explicit Messaging – Generic multi-purpose mes-
saging connection, typically command and 
response message commands.

Each connection type has an extensive number of 
parameters, which can affect the characteristics of the 
communication path. For many Priority/Secondary com-
munications scenarios, a defined set of connections, 
together with their respective parameter settings exist 
under the collective name Predefined Priority/Second-
ary Connection Set. Many of the steps involved in creat-
ing and configuring a connection have been removed 
with this connection set, thus simplifying the network 
configuration.

Predefined Priority/Secondary Connection 
Set
The DeviceNet specification details a number of con-
nections that facilitate data transfer between a Priority 
and Secondary devices. The following sections detail 
the connection types supported by the Gateway Assem-
bly.

• I/O Bit-Strobe Connection: The Bit-Strobe connec-
tion is an I/O connection over which Bit-Strobe I/O 
command and response messages are transferred. 
The Bit-Strobe command is broadcast by the Prior-
ity device and is received by all Secondary devices 
simultaneously. The command message contains a 
single bit of information for each Secondary on the 
network. Each Secondary device is required to 
respond with a Bit- Strobe response message. The 
response message can contain up to 8 bytes of 
information.

• I/O Poll Connection: The Poll connection is an I/O 
connection over which Poll command and response 
messages are transferred. The Poll command is 
transmitted by the Priority, and is directed to a sin-
gle Secondary device. The Secondary device in turn 
responds with a Poll response message. Both the 
Poll command and Poll response messages can 
contain any number of bytes.

• I/O Data Connection: The I/O Data connection is 
part of the Predefined Priority/Secondary Connec-
tion Set, but instead is included for devices, which 
support creating I/O data connections via the 
UCMM (Unconnected Message Manager).

Level of Support
The Gateway provides Group 2 Server level support: A 
UCMM capable device that is configured to act as a 
Secondary for the Predefined Priority/Secondary con-
nection set.

Refer to your Crimson 3.1 User Manual for use and con-
figuration of this DeviceNet card.
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Appendix B: Profibus® DP Secondary Communication

Overview
This appendix describes the Gateway’s support for Pro-
fibus DP and details the configuration steps necessary 
to set up a Gateway Assembly with an S7300 PLC, 
CPU315-2DP via Profibus. It does not provide a 
detailed description of Profibus, but only a brief introduc-
tion, necessary to define the terms that are used 
throughout the remainder of this document.

Introduction
Profibus DP stands for “Profibus for Decentralized 
Peripherals”. Profibus DP is a device level bus that sup-
ports both analog and discrete signals. It has wide-
spread usage for such items as remote I/O systems, 
motor control centers, and variable speed drives. Profi-
bus DP communicates at speeds from 9.6 Kbps to 12 
Mbps over distances from 100 to 1,200 meters.

The protocol supported by the Profibus DP option card 
is Profibus DP Secondary. Therefore, the Gateway 
Assembly must be linked to a Profibus network with a 
PLC.

Profibus Port Protocols
The Profibus option card has one Profibus port. See 
FIG. 22. 

FIG. 22: Profibus PLC Connection

Profibus Option 
Card

PLC Connection
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About Profibus DP
Profibus DP communication takes the form of block 
exchange. Profibus blocks are made of memory bytes 
where 2 bytes make a word and 4 bytes a double word, 
or Dword.

A block is a range of consecutive byte addresses and is 
unidirectional. This means the PLC will exchange data 
read only and write only blocks with DP Secondary 
units. Addresses in each device are independent and 
only relevant to the device for its own program. For 
example, the address range for the first block in the Pri-
ority can start at 256 with a 64 words block length and 
could result in the Secondary with a range starting from 
0 with 64 words length.

However, since blocks are consecutive, this means the 
first block start address, in the above example 256, will 
be the Secondary start address 0. Then, 257 in the Pri-
ority would be 1 in the Secondary, and so on.

Block length can be defined in bytes, words, or double 
words. Since start addresses between the Priority and 
the Secondary can be different, one could give its start 
address and length in bytes, and the other in words. 

For example, the Priority start address is byte 256, with 
a 64 words block length.

• This results in a range from byte 256 up to byte 383. 
The Secondary start address is word 0, with a 64 
words block length.

• This results in a range from word 0 to word 63. FIG. 
23 illustrates this exchange.

NOTE: Do not forget that the Input block is independent 
from the Output block, and although the address range 
is the same, the data are different.

NOTE: FIG. 23 has no connection with the Input Block 
and Output Block in the Gateway Assembly. The termi-
nology used in the tags configuration is from the PLC 
point of view (DP Priority). Refer to Install the Gateway 
Assembly Hardware for more information.

Refer to your Crimson 3.1 User Manual for setup.

FIG. 23: Priority/Secondary Exchange

DP Priority

Output Block
byte 256 to byte 383

Input Block
byte 256 to byte 383

DP Secondary

Input Block
word 0 to word 63

Output Block
word 0 to word 63
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Dimensions

California Proposition 65
CALIFORNIA RESIDENTS

 WARNING: Cancer and reproductive harm – www.P65warnings.ca.gov.
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Technical Specifications

Gateway Network Communication Assemblies
US Metric

Power
 Input

Voltage 100 - 240 VAC
Frequency 50/60 hz AC

Current 1.34 amp Max
Wattage 60 Watts

Weights
 Model 25B471 9.0 lbs 4.1 kg
Models 25B472, 25B473, 
25B486, and 25B489

9.5 lbs 4.3 kg

Gateway Communication Module
US Metric

Communication Ports
USB/PG Ports Adheres to USB specification 1.1. Device only using Type B connection.

Serial Ports Format and Baud rates for each port are individually software programmable up 
to 115,200 baud.

RS232/PG Port RS232 port via RJ12.
COMM Ports RS422/485 port via RJ45, and RS232 port via RJ12.
DH485 TXEN Port Transmit enable; open collector, VOH=15 Vdc, VOL=0.5 V @ 25 mA maximum.

Ethernet Port 10 BASE-T/100 BASE-TX, RJ45 jack is wired as a NIC (Network Interface Card).
Memory
On-board user memory 4 Mbytes of non-volatile Flash memory.
On-board SDRAM 2 Mbytes

Memory card CompactFlash Type II slot for Type I and Type II cards. Used for optional 
database storage only.

Real-time Clock
Typical accuracy is less than 1 minute per month drift. Lithium coin cell battery; 

typical lifetime of 10 years at 25°C.
Environmental Conditions
Operating temperature range 14 to 122°F -10 to 50°C
Storage temperature range -4 to 158°F -20 to 70°C
Operating and storage humidity 85% relative humidity, non-condensing, from 32 to 122°F (0 to 50°C)
Vibration according to IEC 68-2-6 Operational 5 to 150 Hz, in X, Y, Z direction for 1.5 hr, 2 g’s
Shock according to IEC 68-2-27 Operational 30 g, 11 msec in 3 directions
Altitude Up to 6562 ft. (2000 m)
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Graco Standard Warranty
Graco warrants all equipment referenced in this document which is manufactured by Graco and bearing its name to be free from defects in 
material and workmanship on the date of sale to the original purchaser for use. With the exception of any special, extended, or limited warranty 
published by Graco, Graco will, for a period of twelve months from the date of sale, repair or replace any part of the equipment determined by 
Graco to be defective. This warranty applies only when the equipment is installed, operated and maintained in accordance with Graco’s written 
recommendations.

This warranty does not cover, and Graco shall not be liable for general wear and tear, or any malfunction, damage or wear caused by faulty 
installation, misapplication, abrasion, corrosion, inadequate or improper maintenance, negligence, accident, tampering, or substitution of 
non-Graco component parts. Nor shall Graco be liable for malfunction, damage or wear caused by the incompatibility of Graco equipment with 
structures, accessories, equipment or materials not supplied by Graco, or the improper design, manufacture, installation, operation or 
maintenance of structures, accessories, equipment or materials not supplied by Graco.

This warranty is conditioned upon the prepaid return of the equipment claimed to be defective to an authorized Graco distributor for verification of 
the claimed defect. If the claimed defect is verified, Graco will repair or replace free of charge any defective parts. The equipment will be returned 
to the original purchaser transportation prepaid. If inspection of the equipment does not disclose any defect in material or workmanship, repairs 
will be made at a reasonable charge, which charges may include the costs of parts, labor, and transportation.

THIS WARRANTY IS EXCLUSIVE, AND IS IN LIEU OF ANY OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT 
LIMITED TO WARRANTY OF MERCHANTABILITY OR WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE. 

Graco’s sole obligation and buyer’s sole remedy for any breach of warranty shall be as set forth above. The buyer agrees that no other remedy 
(including, but not limited to, incidental or consequential damages for lost profits, lost sales, injury to person or property, or any other incidental or 
consequential loss) shall be available. Any action for breach of warranty must be brought within two (2) years of the date of sale.

GRACO MAKES NO WARRANTY, AND DISCLAIMS ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE, IN CONNECTION WITH ACCESSORIES, EQUIPMENT, MATERIALS OR COMPONENTS SOLD BUT NOT 
MANUFACTURED BY GRACO. These items sold, but not manufactured by Graco (such as electric motors, switches, hose, etc.), are subject to 
the warranty, if any, of their manufacturer. Graco will provide purchaser with reasonable assistance in making any claim for breach of these 
warranties.

In no event will Graco be liable for indirect, incidental, special or consequential damages resulting from Graco supplying equipment hereunder, or 
the furnishing, performance, or use of any products or other goods sold hereto, whether due to a breach of contract, breach of warranty, the 
negligence of Graco, or otherwise.

FOR GRACO CANADA CUSTOMERS
The Parties acknowledge that they have required that the present document, as well as all documents, notices and legal proceedings entered into, 
given or instituted pursuant hereto or relating directly or indirectly hereto, be drawn up in English. Les parties reconnaissent avoir convenu que la 
rédaction du présente document sera en Anglais, ainsi que tous documents, avis et procédures judiciaires exécutés, donnés ou intentés, à la suite 
de ou en rapport, directement ou indirectement, avec les procédures concernées.

Graco Information
For the latest information about Graco products, visit www.graco.com.
For patent information, see www.graco.com/patents.
TO PLACE AN ORDER, contact your Graco distributor or call to identify the nearest distributor.
Phone: 612-623-6921 or Toll Free: 1-800-328-0211, Fax: 612-378-3505
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